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Introduction

Welcome to Using Microsoft Word 2010! This is a special welcome for two reasons.

First, Word 2010 is a highly anticipated upgrade to the Microsoft Office family of
products; many consumers and companies refused to upgrade to the last version
of Word (2007) because it was so different from its predecessors. They wanted to
-see how the world responded to all those new features before committing to an
upgrade. Now they’re satisfied and ready to switch to Word 2010.

Second, and just as important, this edition of Using Microsoft Word is a departure
from past editions. We re-invented Using Microsoft Word for people like you: the
first-time Word user, the busy person who needs to get things done now, and the
task-oriented user who thinks “show me how”—not “give me a lecture on why this
works the way it does.”

In updating this edition of Using Microsoft Word, we focused on productivity and
the importance of completing specific tasks instead of developing detailed knowl-
edge of the program’s inner workings. So, if you’re using this book as your guide to
Word, you need to know how to add a picture to a document, not a dissertation on
the fundamentals of digital photography. You need to access online documents
through Word Web App right now, without pausing to master the infrastructure of
the Internet. In other words, you have work to do, and finishing that work is your
priority. And when you’re in hurry-up-and-get-it-done mode, jargon, technical
details, and lengthy explanations just get in the way. ‘Nuff said about that.

So it’s time to stop talking, except to say this: We hope you like the new version of
Word, and we hope Using Microsoft Word 2010 and its web-based tools meet all
your expectations.

How This Book Is Organized

Each chapter of Using Microsoft Word 2010 dives right into a specific, related set of
tasks. Every section is designed to help you become productive with some aspect
of Word in the shortest possible amount of time. The book focuses on tasks that
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most Word users must complete at least occasionally. Each task is concisely
described, and most descriptions are followed by a set of instructions that walk you
through the task from beginning to end, without taking any side trips. (When it’s
practical to explain a task without using numbered steps, we leave them out. That
keeps things as brief as possible.)

If Word is totally new to you, the first chapter teaches you basic tasks that are vital
to just about any word processing project; by mastering these tasks, you can make
the jump from rank beginner to proficient user in no time. When you’re comfort-
able with the basics, skip around and look up the tasks you need to do when you
need to do them. You don’t have to read the chapters in order; use the material in
the manner that suits you. There are no sample files to install, no long-winded
examples, nothing to get in your way.

This book is divided into six parts. In some cases, the tasks in one chapter are more
difficult than the ones explained in earlier chapters, but that’s OK. If you need to
know something that’s covered in another chapter, a reference will guide you
there. Here are the parts of this book in a nutshell:

Part I, “The Basics of Using Word 2010.” Here you learn essential skills such as
creating a new document, saving and printing documents, entering text, using the
Clipboard, building a document from a template, using Building Blocks to create
parts of a document, checking your spelling and grammar, and using Word’s refer-
ence tools.

Part II, “Formatting Characters and Paragraphs.” This introduces Word’s core for-
matting tools. You learn how to format individual characters, selected text, and
entire paragraphs with Word’s easy-to-use formatting tools. You also learn to apply
Word’s built-in character and paragraph styles, modify styles, and create your own
styles.

Part III, “Organizing Text into Lists, Tables, and Columns.” Simple text-layout
tools such as lists help break up a plain document and make information easier to
follow and remember. Tables enable you to arrange a lot of information in a little
space and can be customized in any way you can imagine. Columns are handy for
creating documents such as newsletters, but have other uses, too. The chapters in
Part III not only help you master these layout tools, but also provide ideas for using
them in your own documents.

Part IV, “Formatting Pages and Documents.” Chapters 10–12 show you the big
picture of document formatting, so you can make your pages look neat, uniform,
and professional. Page formatting includes tasks such as setting margins, choosing
page orientation, dividing a document with breaks and sections, and dressing up
your pages with backgrounds or borders. You can format an entire document by
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applying any of Word’s built-in themes or templates, which provide colors, font
schemes, and other design elements; you can also modify Word’s templates and
create your own from scratch. Part IV also shows you how to add headers and foot-
ers to a document and how to control their appearance and behavior.

Part V, “Taking Your Documents to the Next Level.” Documents can be more
than just text, and Part V shows you how to spruce up any kind of document by
adding pictures, clip art, geometric shapes, charts, diagrams, and other graphical
elements. You also learn to create text boxes and use them to perform cool layout
tricks. Part V also shows you how to add special features such as tables of contents,
indexes, sources, citations, and reference notes—important features for long docu-
ments such as business reports and research papers. (Note that Chapters 15–17 are
available online only.)

Part VI, “Using Word Like a Pro.” (Part VI is available online only.) The last part of
the book introduces you to some of Word’s most powerful features—including a
few that don’t seem to have anything to do with word processing. You learn how to
perform a mail merge, collaborate with other Word users to review and mark up
shared documents, and store documents on the web and access them through
Word Web App. While you’re mastering the art of sharing documents electronically,
you’ll learn how to add features that work only on-screen, such as hyperlinks and
bookmarks. Finally, you’ll learn how to personalize your copy of Word, so it looks
and behaves just the way you want it to.

Using This Book

More than just a book, Using Microsoft Word 2010 is tightly integrated with online
video tutorials, audio insights, and other web-based content, which is designed to
provide you with a media-rich, customized learning experience not available
through any other book series today. Using Microsoft Word 2010 is a thorough
resource at your fingertips.

This book enables you to customize your own learning experience. The step-by-
step instructions in the book give you a solid foundation in using Word, while rich
and varied online content, including video tutorials and audio sidebars, provide the
following:

Demonstrations of step-by-step tasks covered in the book

Additional tips or information on a topic

Practical advice and suggestions

Direction for more advanced tasks not covered in the book
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Here’s a quick look at a few structural features designed to help you get the most
out of this book:

Chapter objective: At the beginning of each chapter is the objective
addressed in that chapter. This enables you to quickly see the information the
chapter contains.

Notes: Notes provide additional commentary or explanation that doesn’t fit
neatly into the surrounding text. Notes give detailed explanations of how some-
thing works, alternative ways of performing a task, and other tidbits to get you
on your way. You’ll find shortcuts, workarounds, and techniques that can help
you avoid pitfalls while using Word. And if a task comes with any risks (such as
losing data), you’ll find a Note giving you a heads-up about it.

Cross-references: Many topics are connected to other topics in various ways.
When another section is related to one you are reading, a cross-reference directs
you to a specific chapter in the book in which you can find the related
information.

LET ME TRY IT Let Me Try It tasks are presented in a step-by-step
sequence so you can easily follow along.

SHOW ME Show Me videos walk through tasks you’ve just got to see—
including bonus advanced techniques.

TELL ME MORE Tell Me More audios deliver practical insights straight
from the experts.

Special Features

More than just a book, your USING product integrates step-by-step video tutorials
and valuable audio sidebars delivered through the Free Web Edition that comes
with every USING book. For the price of the book, you get online access anywhere
with a web connection—no books to carry, content is updated as the technology
changes, and the benefit of video and audio learning.
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About the USING Web Edition

The Web Edition of every USING book is powered by Safari Books Online,
enabling you to access the video tutorials and valuable audio sidebars. Plus, you
can search the contents of the book, highlight text and attach a note to that text,
print your notes and highlights in a custom summary, and cut and paste directly
from Safari Books Online.

To register this product and gain access to the Free Web Edition and the audio
and video files, go to quepublishing.com/using.

Bonus Chapters

Chapters 15–22 are part of your Free Web Edition and can be downloaded there.



1
Creating, Saving, and Printing
Documents

In this chapter, you learn three of the most essential
tasks in word processing: creating a document, saving
it on a disk, and printing it.

If you’re in a hurry to start using Microsoft Word, this chapter is the place to begin.
That’s because the tasks you’ll master in the next few pages form the basis of
nearly every project you will do in Word. Creating a document is the first step in
any word processing job. Whenever you create a document, you’ll probably want
to save it on a disk so you can re-open it and work with it again. And when your
document is finished, you may need to print it so that you can share it with some-
one else (or stick it in a file cabinet).

Luckily, these chores are easy and you can master them in no time. Of course, Word
lets you create, save, and print documents in lots of different ways. But you don’t
need to know them all—at least, not yet. To quickly start, we just cover the basics
here. You’ll learn more advanced options later in this book, where it makes more
sense to explain them.

Starting a Document from Scratch

If you were going to write a letter on paper (an idea that sounds crazy to a lot of
people these days), you would begin by putting a blank sheet of paper on your
desk. When you start Word, it does something similar: It presents you with a new,
blank document that looks just like a piece of paper, as shown in Figure 1.1.

If, for whatever reason, a blank document does not appear in the Word window,
you can create a new one by pressing Ctrl+N. Actually, you can do this when-
ever you want to start a new document, no matter what’s already open in Word.
(You can have multiple documents open at the same time.)

By default, this blank document is already formatted with some standard settings,
which make it suitable for many different uses:

• The page size is 8.5" x 11".

• The page’s top, bottom, left, and right margins are each 1" wide.
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Figure 1.1 A new, blank document in the Microsoft Word window.

• The document uses a simple 11-point font.

• The lines within each paragraph are a little more than single-spaced, and
there’s extra space between paragraphs.

With this blank document on your screen, all you need to do is start typing your
text—or keying, as we computer geeks call it—and your new document starts tak-
ing shape right before your eyes. If you’re dashing off a simple letter, memo, or list,
this document’s default formatting should work just fine. But if not, don’t fret; you’ll
learn all about formatting documents in the next few chapters. For now, let’s just
stick to the basics.

Starting a Document from a Template

Simply put, a template is a special kind of Word document that has been preformat-
ted in some way. The generic blank document that appears when you start Word is
actually based on a template, albeit a simple one. Word offers a handful of built-in
(local) templates that you can use to create many different kinds of documents,
including resumes, business letters, fax cover sheets, and others. Figure 1.2 shows
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Figure 1.2 A template for a professionally formatted business letter.

Every template includes a preset combination of fonts, colors, margins, line and
paragraph spacing, and other formatting characteristics such as headers or footers.
Many templates contain placeholder text that you can customize or replace. Some
templates include graphics, as well. Templates are a huge time-saver because they
let you create professional-looking documents without manually formatting text,
paragraphs, or pages. Just add your text, and you’re done.

The following sections show you how to create a new document from a local tem-
plate and then search Microsoft’s Office.com website for another one. In Chapter
11, “Formatting Documents with Themes and Templates,” you’ll learn how to modify
existing templates and create new ones.

Remember that a template is a different kind of file than a document. When you
create a document based on a template, you open and edit a copy of the tem-
plate, not the template itself. The actual template remains unchanged so that
you can use it again to create different documents.

one of Word’s local templates for a business letter. If you can’t find a local template
that suits your needs, you can search for others online.
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Using a Local Template

A local template is installed on your computer along with Word. You can create a
document from a local template with just a few steps.

LET ME TRY IT

Creating a Document from a Local Template

To start a document from a template, just find one you like and click.

1. On the Ribbon, click the File tab.

The Ribbon was introduced in Word 2007, but it is a new feature for anyone
upgrading from version 2003 or earlier. The Ribbon replaces the menu structure
found in previous versions of Word and provides an easy way to access common
commands and buttons. The Ribbon is divided into tabs, and each tab includes
groups of related features.

2. Click New. The File tab displays the available templates (see Figure 1.3).

3. Click Sample Templates. Word displays thumbnail images of available
templates.

4. Click the Equity Letter template.

5. In the right pane, make sure the Document option button is selected.

6. Click Create. Word creates a new document based on the template and dis-
plays it on your screen.

It’s a good idea to spend some time examining Word’s templates to see which ones
you like best. As you’ll see in Chapter 11, you can modify any template so that it
looks exactly the way you want, insert your own boilerplate text (such as your com-
pany’s name), and then save it as your own. The more time you invest in mastering
templates, the more time you’ll save later in formatting and entering data.

Finding a Template Online

Word’s local templates may be the only ones you ever need. If not, you can expand
your template collection by visiting the Office.com website and searching for differ-
ent ones. Finding a template online isn’t much different than finding a local
template—except that there are hundreds of online templates to choose from.
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File tab

Click New to create
a new document.

Click one of these categories to search
for templates on the Office.com Web site.

Local templates appear in the
top portion of the window.

Word displays a miniature image
of the selected template here.

Figure 1.3 Searching for local templates. Use the top part of the window to find templates
stored on your computer.

LET ME TRY IT

Creating a Document from an Online Template

You can look for templates online without leaving the Word window. When you
download a template from Office.com, Word saves it on your computer so you can
access the template locally whenever you want to use it.

1. On the Ribbon, click the File tab.

2. Click New. The Office.com Templates section shows several categories of
templates that are available online, as shown earlier in the lower part of
Figure 1.3. Each category contains multiple templates.

3. Click Newsletters. Word downloads and displays thumbnail images of
newsletter templates currently available from Office.com.
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4. Click the Business Newsletter template. A larger image of the template
appears in the right pane, along with information about its designer, the
file’s size, and the rating it has been given by Office.com visitors who have
used the template.

5. In the right pane, click Download. Word downloads the template file, creates
a new document based on the template, and displays it on your screen.

When Word downloads a template file, it automatically saves the file with Word’s
other templates. You don’t need to select a disk or folder to store the file in.

To reuse a template you’ve used before, click the File tab, click New, and then click
Recent Templates. Word displays thumbnail images of your most recently used
templates, both local and online.

SHOW ME Media 1.1—Working with Word Templates

Access this video file through your registered Web Edition at

my.safaribooksonline.com/9780132182713/media.

Saving a Document

Soon after you create a document, you should save it—that is, tell Word to store
the document as a file on a disk. When you save a document, you should give it a
logical, plain-English name that will make it easy to identify the file when you need
to open it again. For example, if you write an angry letter to your aunt Martha, you
might name the file “Angry Letter to Aunt Martha,” or some such. You also need to
select a location to store the file, such as on your computer’s hard disk or a network
drive. Word can also save a document in one of several different formats, so you
can choose the one that works best for you.

After saving a document for the first time, you can (and should!) resave it fre-
quently as you work on it. Repeatedly saving a document protects you from data
loss in case your PC’s power goes out or some other problem arises. When you save
an existing document, Word simply updates the file to include any changes you
made since the last time you saved it.

If the need arises, you can create a different version of a document by saving it
with a different name, location, or file type.
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Type a name for your document here.

Use this list to see all the available disks and
folders on your computer and network.

Figure 1.4 Word’s Save As dialog box.

LET ME TRY IT

Saving a New Document to a Disk

The first time you save a file, Word displays the Save As dialog box, and you need to
take a few steps to tell Word exactly where and how to save it. Updating a saved
file is as simple as a mouse click.

1. With an unsaved document open in Word, do one of the following:

• Click the Save icon on the Quick Access toolbar.
• Click the File tab and then click Save or Save As.
• Press Ctrl+S.

The Save As dialog box appears, as shown in Figure 1.4. By default, the dia-
log box shows the contents of the My Documents folder.

2. If you want to save the document in the My Documents folder, skip to 
step 5.
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3. To save the document on a different drive or in a different folder, scroll
through the list on the left side of the dialog box. The list displays all the
drives and folders you can access on your PC or network.

4. Click the drive and folder where you want to store the file.

5. Click in the File Name box and type a name for your document.

6. Click Save. Word saves the document in the location you chose and gives it
the name you specified. The document’s new name appears in the title bar
at the top of the Word window.

By default, Word saves your document in Word’s native *.docx format—the
default file format for Word 2007 and 2010 documents. This format preserves
all of Word’s features and formatting options. Older versions of Word don’t
support all these features.

TELL ME MORE Media 1.2—Understanding Word’s .docx Format

Access this audio recording through your registered Web Edition at

my.safaribooksonline.com/9780132182713/media.

The descriptions and illustrations in this book are based on using Word with
Microsoft Windows 7. If you use another version of Windows, the steps you take
may be slightly different that those described here, and your screen may look
somewhat different from the screens shown in this book. But the same kinds of
tools will be there, so you can get the same results.

Resaving an Existing Document

As mentioned earlier, it’s a good idea to save your documents frequently while
you’re working on them. If you work quickly and make lots of changes to a docu-
ment, you should get into the habit of saving it every minute or so. Frequently sav-
ing a document locks in your changes and protects your work in case the power
goes out or Windows starts misbehaving. (Yes, it happens.)

When you save (resave) a document that has already been saved, Word simply
overwrites the current version of the file with a new one. The updated version
includes any changes you have made since the last time you saved.
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Figure 1.5 Word sometimes prompts you to save your work.

1. With your document open in Word, do one of the following:

• Click the Save icon on the Quick Access toolbar.

• Click the File tab and then click Save.

• Press Ctrl+S.

That’s it—no dialog boxes to get in your way. Just save your work and keep
going.

Even if you aren’t a very good typist—er, keyboardist—you should train yourself
to press Ctrl+S at least once every few minutes while you work. Try to make this
an automatic habit. You’ll keep your work safe without even reaching for the
mouse.

Occasionally, Word asks if you want to save your document. For example, if you try
to close a file or shut down Word without saving the document, Word prompts you
to save it, as shown in Figure 1.5. If you decline to do so, the changes you made
since the last time you saved will be lost.

SHOW ME Media 1.3—Saving a Word Document

Access this video file through your registered Web Edition at 

my.safaribooksonline.com/9780132182713/media.
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LET ME TRY IT

Saving a File with a Different Name, Location,

or File Type

You may need to save a file in a different manner than described in the preceding
sections. This can be necessary, for example, when you need to

• Create a copy of the document with a different name.

• Share a file with someone who uses a different version of Word or a different
word processing program.

• Store a file on a network drive so other users can open it.

All these tasks are done through Word’s Save As dialog box.

When you save a file with a different name, type, or location, you’re actually cre-
ating a copy of your file. (The original version remains unchanged unless you
move, rename, or delete it.) However, Word closes the original version; the copy
appears on your screen unless you saved the copy in a file format that Word can-
not use itself, such as PDF.

1. With your document open in Word, click the File tab.

2. Click Save As. The Save As dialog box appears, as shown in Figure 1.6. The
dialog box shows the file’s current name, type, and location.

3. To save the document on a different drive or in a different folder, scroll
through the list on the left side of the dialog box, and then select the new
drive and folder.

4. To give the document a different name, click in the File Name box and
type the new name.

5. To save the document in a different file format, click the Save as Type
drop-down arrow and choose the desired format from the menu. For
example, if you want to save the document in Rich Text Format (a file for-
mat that can be used by any word processor), choose that file type from
the list.
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Select a different file
format from this list.Select a drive and folder.

Figure 1.6 Using the Save As dialog box to change how a file is saved.

6. Click Save. Word saves the document in the location you chose and gives it
the name you specified. The document’s new name appears in the title bar at
the top of the Word window and the previous version of the document
closes.

Opening an Existing Document

To open an existing document, you need to know where it was saved—or how to
search for it. You can save documents on any storage device connected to your
computer. Whether you store your files on your PC’s hard disk, a network drive, or a
shared folder on someone else’s computer, Word can find and open them.

Of course, this assumes you have the required user rights to open, modify, and do
other things with files stored on a network or someone else’s PC. If you don’t...well,
that’s a topic for another book. Here, we assume you have the rights to do what-
ever you want, without having to beg some goofy network administrator for per-
mission. (They love to say “no” to ordinary computer users, so avoid them when you
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Click a pushpin icon to “pin”
a document to the list.

Click Recent to see the
Recent Documents list.

Click the name of the
document you want to open.

Figure 1.7 Opening a document from the Recent Documents list.

can.) We also assume that you already understand concepts such as disks, folders,
files, and what your computer does with these things. If such matters are a mystery
to you, check Windows’ help system to learn about them.

As with most other tasks, Word lets you open an existing document in several ways.
The following sections show you the easiest methods of the lot.

Opening a Document from the Recent

Documents List

As you open and save documents, Word keeps a running list of them on the File
tab. Logically enough, this list is called the Recent Documents list. The more
recently a file has been opened, the higher its name appears on the list. More
recently used documents push older documents to the bottom of—and eventually
off—the list.

To pick a file from the Recent Documents list, click the File tab, and then click
Recent. The list appears, as shown in Figure 1.7. Click the desired document’s name,
and Word opens it on the Home tab.

To make the Recent Documents list work a bit faster, you can check the Quickly
Access This Number of Recent Documents check box. This option tells Word to dis-
play a certain number of recently opened documents in the menu on the left side
of the File tab. Use the spinner control to set the number of documents to display.
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Now you can choose a document from the menu without having to look over at
the Recent Documents list. What a timesaver! (Yes, that was sarcasm.)

If you use a document frequently, you can “pin” it to the Recent Documents list
so it always appears there. This prevents the document from eventually getting
shoved off the list as you open other documents. To pin a document to the list,
click the Pushpin icon that appears to the right of the file’s name. Click the icon
again if you ever want to “unpin” the document from the list.

Opening a Document from the Open Dialog Box

If you haven’t opened a certain document lately, it may not show up on the Recent
Documents list. But you can open any document through Word’s Open dialog box.
This dialog box gives you access to all the disks and folders on your computer and
network.

LET ME TRY IT

Using the Open Dialog Box

If you know where a document is stored, you can use the Open dialog box to find
and open it.

1. Click the File tab, and then click Open. The Open dialog box appears, as
shown in Figure 1.8. By default, the dialog box shows the contents of the
My Documents folder.

2. If the document you need is in the My Documents folder, skip to step 4.

3. If the document resides on a different drive or in a different folder, scroll
through the list on the left side of the dialog box. The list displays the
names of all the drives and folders you can access on your PC or network.
Click the drive and folder that contain the desired document.

4. Click the document’s name; then click Open.

Instead of clicking a file’s name and then clicking Open, you can just double-
click the file to open it. Alternatively, you can click the file and press Enter. Then
again, you can right-click the file to display a shortcut menu, and click Open.
There are other ways to open a file, as well, but let’s not get carried away.
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Select the drive and folder
that contain the desired file.

Double-click the file's
name to open it.

Figure 1.8 Word’s Open dialog box.

By default, the Open dialog box displays all Word documents that reside in the
folder you select. You can broaden or narrow your search by clicking the File Type
button, which appears to the right of the File Name box. A menu appears, listing
the kinds of files you can display in the Open dialog box. So, if you want to find a
document that was created in WordPerfect 5.0, for example, click WordPerfect 5.x
to see only those documents. Word filters out all the other types of documents in
the list to make it easier to find the file you want.

Conversely, if you want the Open dialog box to display every file (even non-Word
format files) in the selected folder, click the File Type button; then click All Files.
When you choose this option, however, Word may not be able to open every type
of file that appears in the Open dialog box.

Searching for a Document in the Open Dialog Box

If you don’t remember where a document is stored, the Open dialog box features a
search tool that can help you find it.

Using the Open Dialog Box Search Feature

To search a single folder or an entire network for a specific file, you can specify a
word or phrase and tell Word to locate the documents that contain it.
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1. Click the File tab; then click Open. The Open dialog box appears.

2. In the list of drives and folders, click the name of the drive or folder where
you want to start your search. Word will search the specified drive or folder
and every folder and subfolder it contains. For example, if you want to
search all the drives and folders on your computer, click Computer in the
list. If you only want to search a specific drive or folder, click its name.

3. Click in the Search box, and type a word or phrase that will be contained
in the document you want to find (as shown in Figure 1.9). Word starts
searching as soon as you start typing. If Word finds any documents that
contain the word or phrase, it displays their names in the Open dialog box.

4. Double-click the file’s name to open it.

Select the drive or folder
you want to search.

Type a word or phrase to search for in this box.

Figure 1.9 Searching for a document in the Open dialog box.

Searching can be a hit-or-miss proposition, especially if you can’t remember the
name of the file you’re looking for. The search feature is not entirely dependable; it
may dig up files that don’t even contain the word or phrase you specified. Regard-
less, be patient. (After all, you’re dealing with a brainless machine here.) If Word
doesn’t find the file you need, try searching for a different word or phrase or broad-
ening your search to cover more drives or folders.
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Printing a Document

Most documents are meant to be printed at some point in their lives. This is one
reason Word has so many formatting features, as you will learn about throughout
this book. It can take many hours of effort to get a document to look just right on
paper.

The printing process, conversely, is quite easy in Word. That is, as long as a printer is
connected to your PC (either directly or via a network) and all the appropriate
printer-related software is installed. If not, printing can be difficult or impossible. So
we’ll assume you have a printer and it’s working correctly.

There are two methods of printing a document from Word: the really easy way, and
the slightly more difficult way. The following sections show you both.

Quick-Printing a Document

With Word’s Quick Print feature, no setup is required to print a document. As long
as the document looks good on the screen and your printer is working, you can
print a copy of the entire document with a single mouse click.

LET ME TRY IT

One-Step Printing

If you can see the Quick Print button at the top of the Word window, printing is a
snap.

1. On the Quick Access toolbar, click Quick Print. Word instantly sends your
document to the printer.

2. OK, there is no step 2. But that’s the beauty of a one-step anything, right?

If the Quick Print button is not visible on the Quick Access toolbar, you can add it to
the toolbar. For instructions on this and other customizations to Word, see Chapter
22, “Making Word Your Own (online).”

Printing the (Not-so-Much) Harder Way

Quick-printing isn’t always the best option for getting your document onto paper.
You may need to print multiple copies, for example, or change other print-related
settings before sending the document to the printer. If so, you can set up the per-
fect print job from the File tab.
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LET ME TRY IT

Setting Up a Print Job

The File tab’s print options give you complete control over any print job.

1. Click the File tab; then click Print. Word’s print controls fill the window, as
shown in Figure 1.10.

Click this link to open the Page Setup dialog box.

Print controls appear on this side of the window. Print Preview pane

Figure 1.10 Word’s print controls and the Print Preview pane.

2. To see exactly how the document will look on paper with the current print
settings, examine it in the right half of the window. To preview each page,
click the Next Page and Previous Page buttons at the bottom of the
window.

3. To print multiple copies of the document, click in the Copies box, and type
the number of copies you want. (Alternatively, you can click the up or
down counter buttons to the right of the box to set the number of copies.)
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4. The name of your default printer should appear on the Printer button. To
use a different printer, click the button and select a printer from the drop-
down list.

5. By default, Word prints the entire document. To print only a portion of the
document, click the Pages button and select one of the following options:

• Print Selection—This option prints only the text you have selected
before beginning the printing process. If no text is selected, this option is
grayed out (unavailable).

• Print Current Page—This option prints the page that contains the inser-
tion point.

• Print Custom Range—This option enables you to print specific pages or
sections of the document. If you choose this option, you can designate
the pages or sections in the Pages text box. For example, to print only the
second and third pages of your document, type 2-3 in the Pages box.

6. To print on both sides of the page, click the Print One Sided button and
select the appropriate option. The options available depend on your
printer’s capabilities. For example, you might print on both sides of the
page by manually feeding sheets into the printer. By default, Word prints
on only one side of the page with most printers.

7. Word automatically collates documents when it prints multiple copies. This
means one entire copy is printed out before the next copy begins. If you
want your copies to be uncollated, click the Collated button; then click the
Uncollated option.

8. Word prints documents in portrait mode (with the text running down the
long edge of the page) by default. To change this setting, click the Orienta-
tion button; then click the Landscape Orientation option. (In landscape
mode, text runs down the short edge of the page.)

9. To select a different paper size, click the Paper Size button, and then click
the desired size. The available sizes depend on your printer’s capabilities.

10. To change your document’s margins, click the Margins button, and choose
a different set of margins. If none of the preset options suits your needs,
click Custom Margins to open the Page Setup dialog box, as shown in
Figure 1.11. Set the margins in the top of the Margins tab; then click OK.
(Chapter 10, “Laying Out a Document’s Pages,” covers margins and other
page-setup options in detail.)



25Pr int ing a  Document

Figure 1.11 The Page Setup dialog box.

11. Word automatically prints one page of a document per sheet of paper. To
print multiple pages on a single sheet, click the Multiple Pages button and
select the number of pages you want to appear on each sheet.

12. Click Print.

The Page Setup dialog box provides several other print-control options in addi-
tion to those found on the File tab. For example, you can use the dialog box to
select a paper tray, apply borders to your pages, change the way headers or
footers print, and so on. To open the Page Setup dialog box, click Page Setup at
the bottom of the File tab.

SHOW ME Media 1.4—Printing a Word Document

Access this video file through your registered Web Edition at

my.safaribooksonline.com/9780132182713/media.
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Closing a Document

When you finish working on a document, you can either close the file and leave
Word running, or close the document and exit Word. Either way, be sure to save your
document before closing it.

You can close a document and leave Word running by doing one of the following:

• Click File; then click Close.

• On the Windows Taskbar, right-click the document’s button, and then click
Close Window.

• If more than one document is open, click Word’s Close button (at the right
end of the title bar). This closes the current document but leaves Word
running.

To close all open documents and exit Word, click File and then click Exit.
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C

capitalization, changing
AutoCorrect settings, 79-80

cells
borders, 204-206
deleting, 193-194
inserting in tables, 193
merging, 195
resizing by dragging,

198-199
splitting, 195-196

changing
AutoCorrect settings,

79-81
capitalization,

AutoCorrect settings,
79-80

chart types, 319-320
font size, 95-96

format of WordArt
objects, 347-350

proofing options, 65
Quick Style sets, 142-143
section breaks, 233
style definitions, 153
text case, 105

character formatting
clearing, 109-110
copying and pasting with

Format Painter, 106-107

character spacing, adjusting,
103-105

Character styles, 137

charts, 310-311
adding text elements, 323

axis titles, 324-326
data labels, 326
legends, 326-327
titles, 323-324

changing, chart types,
319-320

changing text wrapping
settings, 318

creating, 314-316
editing data, 316-317
layouts, 320-322
modifying, 318
moving, 319
resizing, 318
styles, applying, 322-323

checking spelling and
grammar in entire
documents, 66-69

choosing
bullet characters, 161-163
numbering formats,

166-169
targets for hyperlinks,

440-442

citations, 360
adding, 360-361
deleting, 363
editing, 361-363

clearing
character formatting,

109-110
styles, 148

Click and Type, 33-35

clip art
adding, to documents,

286-287
finding, 287-290
inserting, 287-290

Clipboard, 45-46
pasting from, 46-47

closing, documents, 26

collaboration tools, 399-400

collapsing parts of outlines,
375-377

color, changing font color,
96-97

with Colors dialog box,
98-100

with Font Color palette,
97-98

color sets, modifying in
themes, 252-253

colored backgrounds, adding
to pages, 245-247

colors, modifying in themes,
253-255

Colors dialog box, changing
font color, 98-100

column breaks, creating,
220-222

column width, specifying for
tables, 201

columns, 210-211
adding to tables, 192
converting multicolumn

layout to single
column, 222

creating, column breaks,
220-222

creating custom layout,
218-219

deleting, 193-194
distributing, 202
layouts, changing, 220
preset column formats,

212-213
Columns dialog box,

214-216
Columns menu,

212-214
resizing by dragging, 198
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separating with vertical
lines, 216-217

Columns dialog box, preset
column formats, 214-216

Columns menu, preset
column formats, 212-214

comments, 400
deleting, 405
editing, 405
hiding, 404-405
inserting, 400-402
navigating, 403-404

contrast, adjusting in
graphics, 300-301

converting
multicolumn layout to

single column, 222
text to tables, 183-184

tabbed text, 184-185

copying and moving text,
44-45

copying and pasting text, 45

copying character formatting
with Format Painter,
106-107

cropping graphics, 298-300

cross-references, 449
creating dynamic cross-

references to headings,
449-451

deleting, 451
following, 451

custom paper size, 236-238

custom themes, creating, 258

customized watermarks,
inserting, 244-245

customizing
Quick Access toolbar,

452-453
Ribbon, 461
status bar, 459-460

D

data, editing in charts,
316-317

data labels, adding to
charts, 326

Decrease Indent button, 117

definitions, looking up, 84-86

deleting
bookmarks, 449
cells, 193-194
citations, 363
columns, 193-194
comments, 405
cross-references, 451
documents from

SkyDrive, 433-434
field codes, 278-279
graphics, 309
indexes, 385-386
notes, 367-368
rows, 193-194
sources, 359-360
styles, 156
table of contents

(TOC), 382
tables, 208
text, 37
themes, 259

demoting headings in
outlines, 374-375

diagrams, 312-313
creating, 327-329
layouts, 331-332
modifying, 330
moving, 331
reorganizing, 334
resizing, 330
reversing, 332
shapes, adding/removing,

332-334
SmartArt style, applying,

331-333
text wrapping

settings, 331

disabling AutoCorrect, 84

distributing
columns, 202
rows, 202

dividing documents into
sections, 231-232

document properties, 51

document statistics
finding, 57-58
viewing, 57

documents
adding

indexes, 383
table of contents (TOC),

378-380
attaching to email,

413-414
browsing, 38

Go To command, 40-41
clip art, adding, 286-287
closing, 26
deleting from SkyDrive,

433-434
dividing into sections,

231-232
downloading with

SkyDrive, 432-433
editing with Word Web

App, 430-431
emailing links to, 414-417
evaluating readability,

58-59
extending with Click and

Type, 33-35
hyphenating, 240-241

automatically, 241
manually, 242

inserting one Word
document into another,
55-56

mail merge
adding fields, 394-395
creating, 389-390

moving around in, 38
navigating by browsing

objects, 38-40
numbering lines

with precision, 239-240
quickly, 239

opening, 17-18
from Open dialog box,

19-20
from Recent Documents

list, 18-19
with Word Web App,

426-430
page orientation, 234-236
photos, adding, 284-285
preparing for mail

merge, 389
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printing, 22
print jobs, setting up,

23-25
Quick Print, 22

saving, 12-13
in custom Windows Live

folders, 421-424
with different name,

location, or file types,
16-17

to disk, 13-14
resaving existing

documents, 14-15
searching for, in Open

dialog box, 20-21
section breaks, 232-233

changing, 233
inserting, 232
removing, 233-234

sharing, 417-418
SkyDrive. See SkyDrive
Word Web App. See

Word Web App
starting from scratch, 7-8
starting from templates,

8-9
local templates, 10
online templates, 10-12

text, adding, 27-28

downloading documents
SkyDrive, 432-433

drag-and-drop, moving
text, 49

dragging
resizing

cells, 198-199
columns, 198
graphics, 290-291
rows, 198

sizing tables, 197-198

drawing
AutoShapes, 305
nested tables, 186
shapes, 304
tables, 180

with mouse pointer,
180-182

text boxes, 338-339

drawn objects, grouping,
308-309

dynamic cross-references,
creating to headings,
449-451

E

editing
chart data, 316-317
citations, 361-363
comments, 405
documents, Word Web

App, 430-431
footers, 276
headers, 276
sources, 359
tables, 186-187
text, headers and footers,

277-278
WordArt text, 347

editing privileges, restricting,
408-411

effects, adding to graphics,
302-304

effects sets, modifying in
themes, 257

email
attaching documents to,

413-414
sending links to

documents, 414-417

endnotes, 364-365
inserting, 366-367

envelopes
adding to letters, 353-354
addressing, 351-353

errors
finding and fixing while

you type, 61-62
grammar, fixing as you

type, 63-65
spelling, fixing as you

type, 62-63

evaluating document’s
readability, 58-59

exceptions to AutoCorrect
rules, creating, 80-81

expanding
parts of outlines, 375-377
Ribbon, 461-462

extending documents, with
Click and Type, 33-35

F

field codes, 269-271
deleting, 278-279
inserting, 278-279

fields, 51
mail merge, 390-391

adding to main
document, 394-395

selecting, 391-394

Find and Replace dialog box
changing paragraph

formatting, 134-135
finding text, 72-76

Find command, 69-72

finding
clip art, 287-290
document statistics, 57-58
errors, while you type,

61-62
name of document’s

template, 252-253
synonyms, 86-87
text, 69-70

with Find and Replace
dialog box, 72-76

finding templates, online, 11

fixing errors while you type,
61-62

Flesch Reading Ease scale, 59

following
cross-references, 451
hyperlinks, 442-443

Font Color palette, changing
font color, 97-98

Font dialog box, 91-92

font effects, applying,
101-102

font sets, modifying themes,
255-257

Font Size list, 96

fonts
applying different fonts,

93-95
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applying font effects,
101-102

applying styles, 100-101
changing color, 96-97

with Colors dialog box,
98-100

with Font Color palette,
97-98

changing size, 95-96
character spacing,

adjusting, 103-105
selecting different, 92-93
text case, changing, 105

Footer view, 276

footers, 269-271
changing position of,

279-280
creating different footers

for odd and even pages,
280-281

editing, 276
text, 277-278

hiding on document’s first
page, 281-282

moving between headers
and footers, 276-277

preformatted footers,
inserting, 273-274

removing, 282

footnotes, 364-365
inserting, 365-366

Format Painter, copying
character formatting,
106-107

Format tab, resizing graphics,
291-292

formatting, 90
character formatting,

copying with Format
Painter, 106-107

manual formatting, 148
page numbers, 271-272
tables, 202-203

aligning tables on
pages, 207-208

aligning text in cells,
203-204

borders for cells,
204-206

shading, 206-207
Table Styles, 86

text
with Quick Styles,

140-142
in text boxes, 342

text boxes, 341

Free Web Edition, 5

G

generating indexes, 384-386

Go To command, browsing
documents, 40-41

Go To tab, jumping to
bookmarks, 447-448

grammar, 60-61
checking entire

documents, 66-69
errors, fixing as you type,

63-65

graphics
adding, style and effects,

302-304
adjusting,

brightness/contrast,
300-301

creating hyperlinks,
438-440

cropping, 298-300
deleting, 309
modifying, 290
moving, 296-297
resizing, 290

by dragging, 290-291
with Format tab,

291-292
in Layout dialog box,

292-293
wrapping text around,

293-295

grouping shapes, 308-309

groups, renaming on Ribbon,
465-466

H

Header view, 276

headers, 269-271
changing position of,

279-280

creating different headers
for odd or even pages,
280-281

editing, 276
editing text, 277-278
hiding on document’s first

page, 281-282
moving between footers

and headers, 276-277
preformatted headers,

inserting, 273-274
removing, 282

headings
adding to outlines,

373-374
creating dynamic cross-

references, 449-451
demoting in outlines,

374-375
promoting in outlines,

374-375

hidden characters, viewing,
29-30

hiding
comments, 404-405
headers and footers,

281-282
tabs, Ribbon, 462-464

highlighting
occurrences of search

text, 74-75
text, 106

hyperlinks, 435-436
choosing targets, 440-442
creating

graphics, 438-440
text, 436-438

following, 442-443
jumping to bookmarks,

448-449
modifying, 443
removing, 443

hyphenating documents,
240-241

automatically, 241
manually, 242

477hyphenat ing documents



I

images. See graphics

Increase Indent button, 117

indenting
lists, 173
paragraphs, 115-116

Paragraph dialog box,
118-119

from Ribbon, 116-117
rulers, 117-118

index entries, marking,
383-384

indexes
adding to documents, 383
deleting, 385-386
generating, 384-386
marking index entries,

383-384
updating, 385

information, looking up with
Research pane, 87-88

Insert Mode, 30-32

Insert Table dialog box,
inserting tables, 177-178

inserting
AutoShapes, 305-307
blank pages, 55
bookmarks, 444
building blocks

from Building Blocks
Organizer, 53

from Quick Parts
Gallery, 52-53

cells in tables, 193
clip art, 287-290
comments, 400-402
endnotes, 366-367
field codes, 278-279
footnotes, 365-366
nested tables, 185
nonalphanumeric

characters, 35-37
one Word document into

another, 55-56
page breaks, 229-230
page numbers, 271-272
preformatted headers,

273-274

preformatted page
numbers, 271

section breaks, 232
table of contents (TOC),

customized, 381-382
tables, 174

with Insert Table dialog
box, 177-178

Quick Tables, 178-179
from Table menu,

175-177
text boxes, 336
watermarks

customized
watermarks, 244-245

preformatted
watermarks, 243-244

WordArt text, 346-347

J

jumping
to bookmarks, 445-446

with Bookmark dialog
box, 446

with Go To tab, 447-448
with hyperlinks,

448-449
to and between

notes, 367

K

keyboard, selecting parts of
tables, 191

selecting text, 43

keyboard shortcuts, creating,
469-471

L

Layout dialog box, resizing
graphics, 292-293

layouts
charts, 320-322
columns, changing

widths, 220
creating custom column

layout, 218-219
diagrams, 331-332

legends, adding to charts,
326-327

letters, adding envelopes to,
353-354

libraries
bullet library, 161-162
numbering libraries,

167-168

limiting what others can do
to documents, 408-411

Line and Paragraph Spacing
tool, 125

paragraph spacing,
127-128

line spacing, paragraphs,
124-125

Paragraph dialog box, 126

lines, 28

Linked styles, 137

linking text boxes, 343-344

links to documents, emailing,
414-417

list numbering, restarting,
169-170

List styles, 137

lists, 158
bulleted lists, 158-159

choosing bullet
character, 161-163

creating, 160-161
creating as you

type, 160
nested lists, 171

with bullets only,
171-172

with numbers and
bullets, 172-173

numbered lists, 164-165
choosing numbering

formats, 166-169
creating, 165-166
creating as you type,

166
restarting list

numbering, 169-170
spacing and indents, 173

local templates, starting
documents, 10
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M

mail merge
creating documents for

printing, 397-398
documents, creating,

389-390
fields, adding to main

document, 394-395
fields, setting up, 390-391

selecting fields and
creating address lists,
391-394

preparing main
documents, 389

previewing, 396

managing sources, 355-356

manual formatting, 148

margins, 224-225
creating custom margins,

226-229
precise margins, 226-228
preset margins, 226
setting on rulers, 228-229

marking index entries,
383-384

merging cells, 195

Microsoft SharePoint, 434

mini toolbar, 90-91

minimizing Ribbon, 461-462

Modify Style dialog box,
153-155

modifying
AutoShapes, 307-308
charts, 318
diagrams, 330
graphics, 290
hyperlinks, 443
styles, 152
templates, 265-267
themes, 252

color sets, 252-253
creating custom color

sets, 253-255
effects sets, 257
font sets, 255-257

mouse, selecting parts of
tables, 189-191

mouse pointer, drawing
tables, 180-182

moving
around in documents, 38
around in tables, 187
charts, 319
diagrams, 331
graphics, 296-297
between headers and

footers, 276-277
Quick Access toolbar,

453-454
text, 45

drag-and-drop, 49
text boxes, 340

N

navigating
comments, 403-404
documents by browsing

objects, 38-40

nested lists, 171
with bullets only, 171-172
with numbers and bullets,

172-173

nested tables, 185-186
drawing, 186
inserting, 185

nonalphanumeric characters,
inserting, 35-37

nonprinting characters,
viewing, 29-30

Normal style, 137

Normal template, 262-263

notes
deleting, 367-368
jumping to and

between, 367
switching from one type

to another, 368-369

numbered lists, 164-165
choosing numbering

formats, 166-169
creating, 165-166
creating as you type, 166
restarting list numbering,

169-170

numbering formats,
choosing, 166-169

numbering libraries, 167-168

numbering lines
with precision, 239-240
quickly, 239

O

objects, browsing
documents, 38-40

online chapters, 5

online templates, starting
documents from, 10-12

Open dialog box
opening documents,

19-20
searching for documents,

20-21

opening documents, 17-18
from Open dialog box,

19-20
from Recent Documents

list, 18-19
with Word Web App,

426-430

Outline view, 372-373

outlines, 370
creating, 370-371, 373
expanding and collapsing,

parts, 375-377
headings

adding, 373-374
promoting and

demoting, 374-375
Outline view, 372-373
reorganizing, 376-378

Overtype Mode, 30-32

P

page breaks, 229-230

page numbers
inserting and formatting,

271-272
preformatted page

numbers, inserting, 271

page orientation, 234-236
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pages, borders, 247-248

paper size
custom paper size,

236-238
standard paper size,

236-237

Paragraph dialog box
indenting paragraphs,

118-119
line spacing, 126
paragraph spacing, 128

paragraph formatting,
changing with Find and
Replace dialog box,
134-135

tools, accessing, 112-113

paragraph spacing, 127
Line and Paragraph

Spacing tool, 127-128
setting in Paragraph

dialog box, 128

Paragraph styles, 137

paragraphs, 28, 111-112
aligning, 114-115
borders, 129

Border tool, 129
Borders and Shading

dialog box, 130-131
finding and replacing

paragraph formatting,
134-135

indenting, 115-116
Paragraph dialog box,

118-119
from Ribbon, 116-117
with rulers, 117-118

line spacing, 124-125
Paragraph dialog

box, 126
paragraph-formatting

tools, accessing, 112-113
shading, 132

Borders and Shading
dialog box, 133

Shading tool, 132-133
tab stops

setting, 119-122
setting on rulers,

122-123

setting with Tabs dialog
box, 123-124

Paste Options, 47-48

pasting from Clipboard,
46-47

photos, adding to
documents, 284-285

pictures. See also graphics
resetting, 304

precise margins, 226-228

preformatted headers,
inserting, 273-274

preformatted page numbers,
inserting, 271

preformatted watermarks,
243-244

preparing, documents for
mail merge, 389

preset column formats,
212-213

Columns dialog box,
214-216

Columns menu, 212-214

preset margins, 226

previewing mail merge, 396

print jobs, setting up, 23-25

printing
documents, 22

print jobs, setting up,
23-25

Quick Print, 22
merge documents,

397-398
from Word Web App, 429

promoting headings in
outlines, 374-375

proofing, 57

proofing options,
changing, 65

Q

Quick Access toolbar, 49-50
adding commands,

454-458
customizing, 452-453
moving, 453-454

removing commands, 458
reorganizing, 458
restoring, 459

Quick Access Toolbar menu,
454-455

Quick Parts Gallery, inserting
building blocks, 52-53

Quick Print, 22

Quick Style Gallery, removing
Quick Styles, 143

Quick Styles
applying, 140
changing sets, 142-143
creating, 150-152
formatting text, 140-142
removing from Quick

Style Gallery, 143
versus styles, 139

Quick Styles Gallery, Styles
pane, 144

applying styles, 144-146

Quick Table Gallery, 178-179

Quick Tables, 178-179

R

readability of documents,
evaluating, 58-59

reading statistics,
activating, 60

Recent Documents list,
opening documents, 18-19

Redo button, 50

refining text searches, 71-72

rejecting
AutoCorrect changes,

78-79
revisions, 406-408

removing
character formatting,

109-110
commands from Quick

Access toolbar, 458
footers, 282
headers, 282
hyperlinks, 443
Quick Styles from Quick

Style Gallery, 143
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section breaks, 233-234
shapes from diagrams,

332-334
tab stops, 123
themes, 252
watermarks, 245

renaming
groups, Ribbon, 465-466
styles, 152
tabs, Ribbon, 465-466

reorganizing
diagrams, 334
outlines, 376-378
Quick Access toolbar, 458
Ribbon, 464-465

replacing text, 76-77

resaving, existing
documents, 14-15

Research pane, looking up
information, 87-88

research tools, 84
definitions, looking up,

84-86
synonyms, finding, 86-87

resetting pictures, 304

resizing
cells by dragging, 198-199
charts, 318
columns by dragging, 198
diagrams, 330
graphics, 290

by dragging, 290-291
with Format tab,

291-292
in Layout dialog box,

292-293
rows by dragging, 198
tables by dragging,

197-198
text boxes, 339

restarting list numbering,
169-170

restoring
Quick Access toolbar, 459
Ribbon, 469

restricting, editing privileges,
408-411

reversing diagrams, 332

revisions
accepting and rejecting,

406-408
limiting what others can

do, 408-411

Ribbon, 10
adding groups to tabs,

468-469
customizing, 461
expanding, 461-462
indenting paragraphs,

116-117
minimizing, 461-462
renaming tabs/groups,

465-466
reorganizing, 464-465
restoring, 469
showing/hiding tabs,

462-464
tabs, creating, 466-468

right-clicking, adding
commands to Quick Access
toolbar, 455-456

row height, specifying in
tables, 201-202

rows
adding to tables, 191-192
deleting, 193-194
distributing, 202
resizing by dragging, 198

rulers
indenting paragraphs,

117-118
setting margins, 228-229
tab stops, setting, 122-123

S

sans serif fonts, 95

saving documents, 12-13
in custom Windows Live

folders, 421-424
in default Windows Live

folders, 419-421
with different name,

location, or file types,
16-17

to disk, 13-14
resaving existing

documents, 14-15

searching
for documents in Open

dialog box, 20-21
for special characters,

75-76
for specific text, 70-71

section breaks, 231-233
changing, 233
inserting, 232
removing, 233-234

selecting
fields, mail merge,

391-394
fonts, different fonts,

92-93
parts of tables, 188-189

with the keyboard, 191
with the mouse,

189-191
text, 41-43

separating columns with
vertical lines, 216-217

serif fonts, 95

shading
paragraphs, 132

Borders and Shading
dialog box, 133

Shading tool, 132-133
tables, 206-207

Shading tool, 132-133

shapes
adding to diagrams,

332-334
drawing, 304
grouping, 308-309
removing from diagrams,

332-334
text, adding to, 308-309

SharePoint, 434

sharing documents, 417-418
SkyDrive. See SkyDrive
Word Web App. See Word

Web App

shortcuts, creating blank
documents, 7

showing tabs, Ribbon,
462-464
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sizing tables, 197, 199
by dragging, 197-198
specifying column

widths, 201
specifying row heights,

201-202
specifying width, 199-200

SkyDrive, 417-419
documents, deleting,

433-434
downloading documents,

432-433
saving

documents in custom
Windows Live folders,
421-424

documents in default
Windows Live folders,
419-421

SmartArt diagrams, 327-329

SmartArt style, applying to
diagrams, 331-333

sources
adding, 356-359
deleting, 359-360
editing, 359
managing, 355-356

spacing lists, 173

special characters
adding, 35-37
searching for, 75-76

spelling, 60-61
checking entire

documents, 66-69
errors, fixing as you type,

62-63

splitting cells, 195-196

standard paper size, 236-237

status bar, customizing,
459-460

storing templates, 261-262

styles, 136-138
adding, to graphics,

302-304
advantages of, 138-139
applying

with Apply Styles pane,
146-148

to charts, 322-323
from Styles pane,

144-146
changing definitions, 153
Character styles, 137
clearing, 148
creating, 148-151
deleting, 156
font styles, applying,

100-101
Linked styles, 137
List styles, 137
modifying, 152
Normal style, 137
Paragraph styles, 137
Quick Styles. See Quick

Styles
versus Quick Styles, 139
renaming, 152
Table styles, 137
updating

definitions, 153-155
to match selected text,

155-156

Styles pane, Quick Styles
Gallery, 144

applying styles, 144-146

switching
from one type of note to

another, 368-369
to Word from Word Web

App, 431-432

symbols, adding, 35-37

synonyms, finding, 86-87

T

tab stops
removing, 123
setting, 119-122

on rulers, 122-123
with Tabs dialog box,

123-124

Tab Type button, 122

tabbed text, converting to
tables, 184-185

Table menu, inserting tables,
175-177

table of contents (TOC), 378
adding to documents,

378-380
deleting, 382
inserting customized,

381-382
updating, 382

Table styles, 137

tables, 174
adding text to, 187-188
cells

deleting, 193-194
inserting, 193
merging, 195
splitting, 195-196

columns
adding, 192
deleting, 193-194

converting text to,
183-184

deleting, 208
distributing rows and

columns, 202
drawing, 180

with mouse pointer,
180-182

editing, 186-187
formatting, 202-203

aligning tables on
pages, 207-208

aligning text in cells,
203-204

borders for cells,
204-206

shading, 206-207
with Table Styles, 86

inserting, 174
with Insert Table dialog

box, 177-178
Quick Tables, 178-179
from Table menu,

175-177
moving around in, 187
nested tables, 185-186

drawing, 186
inserting, 185

rows
adding, 191-192
deleting, 193-194
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selecting parts of, 188-189
with the keyboard, 191
with the mouse,

189-191
sizing, 197

by dragging, 197-198
specifying column

widths, 201
specifying row heights,

201-202
specifying 

dimensions, 199
width, 199-200

Tables Styles, 86

tabs
adding new groups

(Ribbon), 468-469
creating, for Ribbon,

466-468
renaming on Ribbon,

465-466
showing/hiding, on

Ribbon, 462-464

Tabs dialog box, setting tab
stops, 123-124

targets, choosing for
hyperlinks, 440-442

templates, 259-260
applying different

templates to
documents, 263-265

creating new, 267-268
finding name of, 252-253
modifying, 265-267
Normal template, 262-263
for older versions of 

Word, 261
starting documents, 8-9

local templates, 10
online templates, 10-12

storing, 261-262
types of, 260-262

text
adding

to documents, 27-28
to shapes, 308-309
to tables, 187-188

aligning in cells, 203-204
converting to tables,

183-184
tabbed text, 184-185

copying and moving,
44-45

copying and pasting, 45
creating hyperlinks,

436-438
deleting, 37
editing, in headers and

footers, 277-278
finding, 69-70

with Find and Replace
dialog box, 72-76

formatting
with Quick Styles,

140-142
in text boxes, 342

highlighting, 106
moving, 45

drag-and-drop, 49
refining text searches,

71-72
replacing, 76-77
searching for specific

pieces of text, 70-71
selecting, 41-43
wrapping around

graphics, 293-295

text boxes, 335
creating from building

blocks, 336-338
drawing, 338-339
formatting, 341

text, 342
inserting, 336
linking, 343-344
moving, 340
resizing, 339

text case, changing, 105

text elements, adding to
charts, 323

axis titles, 324-326
data labels, 326
legends, 326-327
titles, 323-324

text wrapping settings
changing in charts, 318
diagrams, 331

themes, 249-250
applying, 250-251
browsing, 251-252
creating custom

themes, 258

deleting, 259
modifying, 252

color sets, 252-253
creating custom color

sets, 253-255
effects sets, 257
font sets, 255-257

removing, 252

titles, adding to charts,
323-324

toggling between Insert and
Overtype Modes, 30-32

toolbars
mini toolbar, 90-91
Quick Access toolbar,

49-50
adding commands to,

454-458
customizing, 452-453
moving, 453-454
removing 

commands, 458
reorganizing, 458
restoring, 459

tools
Border tool, 129
Line and Paragraph

Spacing tool, 125
paragraph spacing,

127-128
Shading tool, 132-133

Track Changes feature,
405-406

accepting and rejecting
revisions, 406-408

U

Undo, 49-50

updating
indexes, 385
style definitions, 153-155
styles to match selected

text, 155-156
table of contents

(TOC), 382
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V

vertical lines, separating
columns, 216-217

viewing
document statistics, 57
hidden characters, 29-30

W

watermarks, 242-243
inserting

customized
watermarks, 244-245

preformatted
watermarks, 243-244

removing, 245

Web Apps, 417

widths, changing column
widths, 220

Windows Live, 417-418

Windows Live folders
saving documents,

419-421
saving in custom folders,

421-424

Word, switching to from
Word Web App, 431-432

Word options dialog box,
adding commands to,
Quick Access toolbar,
456-458

Word templates, 260
with macros, 261

Word Web App, 426
documents, editing,

430-431
opening documents,

426-430
switching to Word,

431-432

WordArt, 345
creating, 346-347

WordArt objects, changing
format of, 347-350

WordArt text
editing, 347
inserting, 346-347

wrapping text around
graphics, 293-295
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